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Course Description

QAD designed this course to cover the basics of using the QAD Enterprise Applications Standard
Edition (SE) and Enterprise Edition (EE) using the QAD .NET UI.
The course includes:
« An introduction to the QAD .NET UL.
Navigating the QAD .NET UI.
Application help options.
QAD .NET Ul programs
Basics of browses

Students will also learn by labs designed to reinforce concepts presented in this training guide.

Objective

Learn how to navigate QAD Enterprise Applications using the QAD .NET UI. In addition,
students will be able understand the help options, different programs and be able to use browses
effectively.

Benefits

Students will become more efficient in the use of QAD Enterprise Applications.

Audience
« Implementation consultants
« Members of implementation teams
- Key users

Prerequisites

« Some familiarity with Enterprise (EE) and Standard (SE) editions of QAD Enterprise
Applications

Course Credit and Scheduling

This course is designed to be taught in two days.

Virtual Environment Information

The hands-on exercises in this book should be used with the “Enterprise Edition 2012 r01 -
Training” environment, in the “10USA > 10USACO” workspace.

MQAD



QAD Resources

If you encounter questions or problems on QAD software that are not addressed in this book,
several resources are available.

Product Help

All QAD products ship with integrated help systems. including Character Ul Help, .NET Ul Help,
QAD Assist, and QAD Guide Me help. In addition QAD has extensive Web Resources

The QAD Web site provides product and company overviews.
http://www.qad.com/

From QAD’s main site, you can access QAD’s Learning or Support sites.

QAD Learning Portal for Training Opportunities

To view available training courses, locations, and materials, use the QAD Learning Portal. Choose
Learning under the Global Services tab to access this resource.

QAD Support for Product Documentation and the QAD Knowledgebase

To access release notes, user guides, installation and conversion guides by product and release,
visit the Support Web site. Support also offers an array of tools depending on your company’s
maintenance agreement with QAD. These include the Knowledgebase and direct links to QAD
Support experts.

Choose Support under the Global Services Tab

Any QAD customer can register for a QAD Web account by accessing the Support Web site and
clicking the Accounts link at the top of the screen. Your customer ID number is required. Access to
certain areas is dependent on the type of agreement you have with QAD.

MNQAD
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Objective

Chapter Objective
« Students will be introduced to the following
in the QAD .NET Ul:

- The different types of Ul mode in QAD
Enterprise Applications

- Attributes of component-based and non-
component based programs

- The QAD .NET Ul Login window

MQAD



Introduction to QAD .NET Ul 7

Benefits

Chapter Benefits

« Students will understand the following in the
QAD .NET Ul:

- The different Ul modes available in QAD
Applications

- The different attributes of component-

based and non-component based
screens

- How to log in to the QAD .NET Ul

MNQAD
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Training Flow

Training Flow

Infroduction
Navigation

« Application Help

« Programs
Browses

« Character Ul

MQAD



Introduction to QAD .NET Ul 9

Introduction — QAD .NET Ul

Introduction
« The QAD .NET Ul

- Microsoft Technology
* Incorporates familiar Ul features
* Reduces learning effort by users
- One interface, two modes
+ QAD .NET Ul
« Terminal Mode (rendering of Character Ul)

MNQAD
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Character Ul

Character Ul

P 172.16.28.81 - PuTTY o
|

QHI : gaddb-

mfmenu Hain Henu 05/z26/ 10‘

1. Items/Sites 13. Product Structures 25. General Ledger

2. Addresses 14. Routings/Work Center 26. Multiple Currency

3. Inventory Control 15. Formula/Process 27. Accounts Receivahle

4. Warehousing 16. Work Orders 28. Accounts Payable

5. Purchasing 17. Lean Hanufacturing 29. Tax Management

& 18. Repetitive 30. Cost Management

7. Sales Orders/Invoice 19. Quality Hanagement 31. Banking/Cash Mgmt

8. Configured Products 20. Product Line Plan 32. Fixed Assets

Da 21. Resource Plan 33. Enterprise Ops Plan

io. 22. Forecast/Haster Plan 34.

11. Service/3Support 23. Materials Rgmts Plan 35. EDI eCommerce

1z. Distribution Plan 24. Capacity Romts Plan 36. System Admin |
Please select a function. F4 or blank to EXIT . H
Fress FZ for Help ™

Unlike the QAD .NET user interface, the character user interface depends completely on input
from the keyboard. Because it is not a graphical user interface, all navigation is based on:

- A command-prompt interface to execute programs
« Combinations of keystrokes to issue commands within programs
» Navigation without use of a mouse through the UNIX character interface.

Component-based functions are accessible only through the QAD .NET UI. You cannot access any
of these functions from the Character Ul.

MQAD



Introduction to QAD .NET Ul 11

Terminal Mode in the QAD .NET UI

ltern Master Maintenance X |

Terminal Mode in the QAD .NET Ul

Fromo Group:

Ttem Number: [ Description:
Unit of Measure:
ITtem Data
Prod Line: Item Type: Drawing:
Added: Status: Revision:
Design Group: Group: Drawing Loc: Size:

Price Break Category:

ABC Class:
Lot/Serial Control:
Site:

Location:

Location Type:
Auto Lot Numbers:
Lot Group:

Article Number:

HNo

Item Inventory Data

Average Interval:
Cycle Count Interval:
Shelf Life:
Allocate Single Lot: No
Key Item: No
PO Receipt Status:
WO Receipt Status:

Memo Order Type:

Rctive: No
Active: No

With the QAD .NET Ul interface, you can still use non-component based programs in a CHUI
interface. You do this by selecting Terminal Mode in the Program Properties option. This is
described in the section on Programs.

MNQAD
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Attributes of Component-Based Programs

Aftributes of Component-Based Screens

- Underlying Microsoft.NET Technology
 Traditional Windows screen navigation
- Familiar click and point functions

- Right-click options

MQAD



Introduction to QAD .NET Ul 13

Component-Based QAD .NET Ul Screen

Component-Based Screen
Journal Entry Create *
¥ GoTo ~ Actions = %7 Tools = | # Attach | =) Print 4] Preview
Attachments )
Yeu g | o8 Pasting [iste D4/30/2000 +
Dapbook Code » |¢|  DD0DDOCOO Save As Tamplate
Descrption Template Code Replacemant
Orignal Posting 000000000
Felerence
GL Account 4 GLDescrption ¢ SubéccountC 4 CostCe ¢ Descrigtion ¢ Trans 4 TC Detat TC Credit ¢ Intercompary Code ¢
L4
4| i »
CurencyView  [Tiansaction Curency  » Towl TC 000 000]
Saveand Create “ Save Cose

You use traditional mouse-clicks, tabs, and keyboard tabbing to navigate the component-based

screen.

MNQAD
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Attributes of Non-Component Based Screens

Aftributes of Non-Component Based Screens
A rendering of the Character Ul for the .NET
Ul
Similar tabbing and keyboard navigation

Screen navigation bar for some non-
component based screens
- Enabledin Tools | Options

Non-component based screens are based on traditional procedural-written Progress-based
technology.

MQAD
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Non-Component Based QAD .NET Ul Screen

Non-Component Based Screen

Sales Order

Header Lines

> Header » [ 2
Header

Order ||

Sold-Te

Details
Order Date:
Fequired D ate:
Fromise [ ate
Due Date:

Perforrn D ate:

[Sales Order Maintenance

# GoTo ~ Actions ~ |

Copy = =) Print a Preview & Attach

v Order

> |

Sold To

Line Pricing:

Manual:

D aybook Sel

Chaninel

Project:

Bill Ta

Ship-Ta

Confirmed:
Currency:

T anable

Ship-Ta

Language:

Fised Pnce:
Credt Temsz:

All Standard and Enterprise Edition programs are non-component based, except QAD Enterprise

Financials.
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Login Menu

Login Menu

Login |

FRAQAD

Enterprise Applications

User. \ |
Password: | |

Log on to: igadui - |

Starting the QAD .NET Ul

To launch the client, select the QAD Applications icon or Menu item under Programs on the Start
Menu. Enter your assigned user and password if assigned. Select a system environment for which
you have permissions from the drop-down menu.

MQAD



Introduction to QAD .NET Ul 17

Summary

Chapter Summary

There are different types of Ul mode within
the QAD .NET Ul

Component and non-component based
screens have different visual and navigation
afttributes

You launch the QAD .NET Ul from a menu
option or desktop icon and select an
environment from the drop-down menu

Exercise and Knowledge Check

1 You can use the mouse for certain functions in Terminal Mode. (T/F)
2 Some component-based functions are configurable in Terminal Mode. (T/F)
3 Which of the two interfaces depends completely on input from the keyboard?

4 Which Enterprise Edition application is component based?

MNQAD
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Objective

Chapter Objectives

« Learn about the different ways of navigating
in the QAD .NET Ul.

MQAD



Navigating the QAD .NET Ul 21

Benefits

Chapter Benefits

« You willbe able 1o navigate the different
types of screens and programs within
Enterprise Applications.

MNQAD
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Training Flow

Training Flow

Introduction

+ Navigation

- Application Help
Programs
Browses

- Character Ul

MQAD
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Switching Domains

With the workspace selector toolbar along the bottom of the screen, you can quickly change

workspaces and domains.

MNQAD
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Workspace Menu

Workspace Menu

Workspace  Window Help
CaAMN Canada - Demao [CAD] > CAN-01 Canada
CHINA China-Demao [CHY] > CHINA-D1 CHINA-O1
EMEA EMEA [EUR] > Germany Germany
FRA France - Dema [EUR] » FRA-01 France
FRA France - Dema [EUR] > FRA-02 entité france 02
MEX Mexico - Dema [MMxXMN] > MEX-01 Mexico
Q4D Systern Domain [USD] > 999 - SYSADM (1)
Train Puerta Rico - Demo [USD] > Entity C 55k Training Entity
Train Puerta Rico - Demo [USD] > Training Entity For Training
UK. United Kingdom [GEF] > UK-01 UK-01
LISAUSA - Demo [USD] > Consol-01 Consolidation 01
US4 USA-Demo [USD] » US-4 USA-A
¥ LSAUSA-Demo [USD] > USA-01 USA Primary Entity (1)
US4 USA-Demo [USD] » US-B USAB

More ...

N o~ A~

Manage Workspaces. Activate and deactivate workspaces from a list.

A workspace typically represents a domain. When you exit the QAD NET UI, the active
workspace is saved and displays when you log in again. This lets you change domains by selecting
from the list. The check mark signifies the domain that is currently active.

You can also change your workspace from the Workspace Selector along the bottom of the QAD
NET Ul window. In The SE edition you log in to the default domain as defined in User
Maintenance.

MQAD
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Navigating Process Maps

25

Maka

Invantory

Enable

Engage

Nawgqhng Process Maps

@@@@@@
@W

Procurement
and Receiving

s Select Global
Su DDWlers

Supplier

Processes, or process maps, are graphical models of workflows that link to programs, browses, and
other process maps using advanced features of .NET technology.

Process map nodes provide drill-down navigation to individual programs within process flows.

MNQAD
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Drill-Down and Breadcrumbs

Drill-Down and Breadcrumbs

Supply Chain Process Model » Select Global Suppliers » Schedule Purchase Orders

Schedule Purchase Orders

Planning and
Scheduling Purchasing

Processes are built with two basic components:
- Nodes are represented by various shapes and typically indicate a step within the process.

» Connectors are lines with arrows that indicate the direction of execution for the steps (nodes)
within the process.

You navigate the process map using nodes, and can re-trace your steps using the hyperlinked
breadcrumbs at the top of the screen.

MQAD
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Workspace Screen

File Edit Tools ‘Workspace

#43 Collections
) Metrics

#47) Customer Management
#{) Supply Chain

FH Manufacturing

#5) Financials

F{3) Master Data

HHT) Sypstem Administration

By Sales Order Maintenance
%5 Purchase Order Maintenance

" Quick Search

Statswith  ~
#@ ltems
+- ¢ Sales order and items

d

Mainmenubar

i

Help

Menu search for prograrms,
browses, and other menu items

—Applications Area

T

«—— =+ Favorites Area

[P

= CQuick Search Field

+«— Browse Groups

E

Workspace Screen

« Use the Main menu bar to access menus for file, edit, tools, workspace, window, and help.

L]

Use Menu search to locate programs.
The Application area displays the applications that are available in the QAD .NET UI.
Favorites area lists frequently used programs.
Use Quick search area top search for a value across all of the fields in a browse.
Browse Groups group browses for quick search.

MNQAD
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Favorites

Favorites

Eilaols Workzpace Window ﬂehl:nrlJi Righ‘l‘_c”ck O
|— program and select

;
©,19257  Process Data Maintenanc| L3 Find in Menu Add -I- F -I-
Br257  CommisionDelal Bromss O ravories, or

I%E Add To Favorites %
w2157 Log Charge Pending Invoi

b Plrchase Drder Mantenancs e

BJET UM Group by Itern Nurmbe Open drOg Ond drop
sb 4257 Hanging lad_det Report | Diesign

. £ > :

mBATA Ship Delivery Time Mainte = m ‘I‘ ‘I‘ h

B 55.7.2 Ship Delivery Time Inguiry EloRees p r O g ro S o e
m{} 5.5.7.4 Supplier Contrals Maintenance & .

5&3‘; 5ATE Supplier Planning Schedule Maint F ‘I‘

5577 Supplier Shipping Schedule taint : O Vo r | e S O re O

I.—-'l FRT13 Shin Sehedule Varianee Camnare V_‘

" s . Programs that are

' used frequently so
that a search is not
required

MQAD



Navigating the QAD .NET Ul 29

File Menu

File Menu

File  Edit Tools ‘Workspace ‘Window Help
Logoff

Fage Setup

Frint Preview

e

Print Ctrl+P

1USAUSA-Dero [USD] » USA-01 USA Primary Entity f Hame Page
2 Q4D Systerm Domain [USD] > 995 - SY5ADM f Home Page

Ezxit

The File menu commands include:

Logoff/Login. Log off from all applications running in the QAD NET UI. You can log in as a
different user if security allows.

Page Setup. Defines print output for browses; this has no impact on maintenance programs.
Print Preview. Generates a print preview of a browse prior to print.

Print. Open the print dialog so that you can print the data for a browse or the screen for other
programs.

Program History. The section below Print displays the last six programs that you have opened.
You can choose to open one of these programs directly from this pull-down menu.

Exit. Close the QAD NET Ul and log off any open applications.

MNQAD
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Edit Menu

Edit Menu

File Edit | Tools ‘“Workspace ‘Window Help

B o cuox
I Wam BB Copy Ctrl+ |
B B Paste Cirl+ [

lom IL'

&]‘E‘ + Menu Search Crl+hot

G
#7) Supply Chain

[+J{fj Manufacturing

e {5 Financials

A= Master Data

@

m

The Edit menu commands include:

Cut, Copy, and Paste

These are standard Microsoft commands. View associated shortcuts on the screen above.

Menu Search

While In any screen you can immediately go to Menus search by using the shortcut Ctrl + M
or select menu search.

MQAD



Navigating the QAD .NET Ul 31

Tools Menu

Tools Menu

File Edit Tools ‘“workspace ‘window Help

|

*13- -'5'.|:\|:llliw::a't\:| Options...

o

[ L

[] Internet Properties

#3 Collecti & Delete History
[#47) Metiics

Manage Workspaces
#T Customer managsmsn

] Supply Chair
[#7) Manufacturing

Financials

M aster Mata

« Options. View administrative information and set personal options for browses and other
application settings. For more information, see next slide Settings the user cannot configure
are viewable from Help| View Configuration.

« Internet Properties. Update the same settings that display when you select Internet Options
from the Tools menu in Internet Explorer.

« Delete History. Delete the following data

Temporary files: Internet Explorer cache and IE cookies, and cached resources created for
the current configuration.

Session information: the graphical state stored by the GUI persistence manager. Also
deletes user input, such as last configuration, last workspace, most recently used menu
items, and credentials.

- Manage Workspaces. Activate and deactivate workspaces from a list and reorder them.

MNQAD
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Tools - Options

Tools — Options

Y Options

=Joes

El Browse

Cancel transaction on drill change
E Cell Font

Link Fant Color

Row Alternating Color

True
Microsoft Sans Serif, 8.25pt

M elue

[ 235, 235, 235

Row Background Color |:| white
Rows Per Page 100
El Desktop
Auto advance on the last data field False
E Cell Font Microsoft Sans Serif, 8.25pt

Prompt user on open transaction
Sereen Navigation Bar

True
True

'Text' Report Font Lucida Console, .25pt
UI Extensions True

E General
allow Multiple Applications True
Left Navigation Panel Style Studio Toolbox

Show Workspace Selector True
[T P .

| allow Multiple Applications
If this value is set to true, then multiple instances of the application can be launched,

Canct]

3

Field Descriptions

Cancel transaction on drill change. In a maintenance screen, you can then use the up and down
arrows on the keyboard to select next item from an attached look-up browse.

Cell Font. Specify standard windows font name, style, and size to use for cell data values.

Link Font Color. Choose the color to use for hot-linked data values. You can choose system
colors, Web colors, or custom colors from a color palette.

Row Alternating Color. Specify the background color for every other row in the browse
display.
Row Background Color. Specify the background color for data rows in browses.

Rows Per Page. Specify the number of data rows to retrieve for each browse page of data in
the browse. The default is 100.

Desktop Auto advance on next data field. Specify whether to go to the next frame after leaving
the last field in the current frame.

Cell Font. Specify the font name, style, and size to use for cell data values. This field displays
a standard Windows font dialog where you can select a font, font style such as bold or italic,
and font size.
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33

Window Menu

File Edit Tools

(o} Applica

! purchaze order mainten

Wwotkgpace  ‘window  Help
Cloze All Windows
= ance | Purchase Order Maintenance X
1 Sales Order Maintenance . .
== ions " L Copy '| @l Frint 4 Previe
sEg‘;l:urchase Order Maintenance ¥ 2 Purchase Order Maintenance i
Header Lines 71
> Header B P Tax b L B Delive
Header
Purchass Order:| | ,JTJ| Supplier:
ol
: Supplier
Select your favorite application from the
Applications menu and drag it into this :
window to save it ;
4
Details
(Order D ate: Price Thi:
e

This menu displays the programs in the order in which they were opened. Close all windows shuts

all screens on the workspace.
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Component and Non-Component Based Programs

Fde Edn Tool Workipsce Window Help

51 Syttem Admesstation
17 Coporsts Strchae Sehp Hen
517 Stuchan Sehp Mo
% (2 Doman Martsnarcn
=17 Eriity Marisnarce
o
i Entty Hodéy

10 Cond Toemt Marderarcs
5 () b Sishus Corde Msrdersarce
5} Withhokdng T a« Pepart
&5 Compernsicn o Thad Pary Flepor
e L
£ (7% Doman Comtaris Mans
i Wiy Mastensnce

[ GL Aceount Bows for GL Transacton: View Exterded
Py Sousead Ertry Croes Cy Excol bbogroion
(=L

Py Sakes D Maintenance

[ WHT Tam Conicate View

Enty Cramte
W GpTor | Acbont *
Aitachments

Entty Code

Entty Descigion

Bunres: Falvon
Localzsion Code

General [ Shaied Sets | Addaonal OL Humbenng | Taxes

Chack Burkgets on Dvedls
Pleverce PLL Alevakistions
Coruodshon Ertly
Dutcenss fos Oy

vt Ugper Livt

M Sengp.

O i Nt Fstctn

Toals =| # smach

All other programs are
nor-component based

& Print )

&

() Global Flegustion Merss
+ () Euhat Puechase Ouders Mars
1 Suppler Schedules Menms
Fiy Puachase Oider Mamtenance
[ Puschuse Oidet Bsonren
) Puachuse Cides Asperts Merus
@ Puchace Oider Pirt
£ Puchusing RlecegtyRetam: Men
5 Purchass Order Recects

Component and Non-Component Based Programs

Enterprise Financials and System
Administration orograms only

= Purchsss Ovder Retums %

- GaTo
Purchate Order bom 1

Purchase Didec | from
ATV Nk
ShprFrom
ShoTo

Puchaia Raceipt Docunent Firt

£ PO Riscept Cont Biowse:
3 PO Rlaceipt Packing Sip inainy
d Purchar Fizorpt Reper
b Prchace e st |

& Purchse fishem Diocumend Pret

[ Usrvouchered Receipis an of Dafe

%y PO Contares Marierance.
T PO Shepe Mardinarcs

13 PO ShigperTortanes inguey
=5 PO Fiscal Receiving

& PO Fircal Foscsip iy
3 PO Shiper Recon:
= PO Sheper Deletnifschrrs

Actions |

Copy | Pont o Pravew | @ Anach

Only Enterprise Edition Financials and some System Administration programs are component-
based. All other applications are non-component based, including Standard Edition Financials.
Component-based programs have individual maintenance programs, such as Create, Modify, and

Delete.
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Navigating Component-Based Screens

Navigating Component-Based Screens

J Journal Entry Create
# GoTo - Actions * ¥ Tools "| & Atach | (= Print o Preview
Attachments ®
Year [2od]| o5 | PosingDate  |05/05/2010 - |
Daybook Code | P |e | 000000000 | L Twr [ J Save As Template
Description | | Template Code i # i Replacement
Dn?mal Fosting I Pl Sequerce Nurber | 000000000 |
©  Relerence L | N it
GL Account 4 GL Description 4 Sub-AccountC ¢ CostCe o Description ¥ Trans % TC Debit L3 TC Credit +  Intercompany Code
»
[l [ 1 [
Currency View !_T_rans_a_ctiqp Currency  ~ | TolalTC | U.UUH 0,00/
[ Saveand Create H Save H Close

Because the component-based Ul is based on Microsoft .NET technology, it incorporates familiar
mouse, click and drag, and tabbing functions.
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Horizontal and Vertical Tab Groups

Horizontal and Vertical Tab Groups

Sales Order Maintenanca Iilnm Mastar Maintenancs Xl
Mew Horizontal Tab Grou
- GoTo~ I Ac D e P | @ Atach
e [T Mew vertical Tab Group
Close
It Fl P =
ild sibol IRl | Bales Order Maintenance X Htemn Master Maintanance X
b iiem P lemi Closz al ! ST ey e -
a - L *| (s Print i
Item Close Other: ln.au [oons _ Ssla-Te: CE4000  Bill To: CE4O00  Ship-To: CE4OIO Bl pcignatasallion """_:m s Froview | e
23 ltem: (%) ltem Number
Itern Number:| | "] Move Tab tc 5sld-Ts Ship-Te v
. | | Lot Bike Civy Laex Bike City tem  Planing  Frice
Urit of Measure: Wizichsvzasse 67 Wicichsvzasse 67 > ltem > > >
: Lase 26749 Lass g
i Item Data Sl i Item Nierber
; ) Uit of Measure:
‘| Purchase Order Maintenance * L tzdes Davs; OE/2M07 Line Picing: Yer Condizmed: Ver 08/1L07
; Fequized Dame; 0/22/07 Maneal : Cuzeency: CUR Lanquage ]
| GoTa v Actions ¥ | .= | Co| | Promize Bare Daybook Few: SLI Taxable: Yer 8 llem Data
i ; " Due Bave: 08/22/07 Channel Tixed Price: Yes
Purchase Order: Pertors Dase Frefece: Credi® Tesns: 90D Piod Lire: llem Type:
- Pricing Dave: 08/20/07 bzg Inw: Sime: EMES
Hexdep| Lines Puzchase Ordes Credit Temms Inverest v 0.0 Added St
Detait s inif Femazk: e/ Ldin:
> Header » [ P Ta { " Beprice/Ldis Desion Grous Gow
Header
. Promo Geoup:
Purchase Order: ' |
Fi=6s 17Help =Ins 4°End 7T=Recall 8=Clear =Frev L0eNext
Item Inventory Data
Supplier ABC Class: Averad
Lot/Sensl Cortiok. Cycle Cou
-
Ste:

There are two methods or views of making multiple screens appear on the desktop. This works
especially well with the QAD .NET Ul browse programs.
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Help Menu

2 Blocked Customer Maintenance
/“b Controlled Customer Maintenance

Select your favorite application from the
Applications menu and drag it into this
window to save it

File Edit Tools ‘wWorkspace Window Help

®

& ee®

Search
Application Help
Wiew Configuration

About

Name:
Addiess:
Addiess:

Addiess:

m

City:
Country:
Aifention

Supplier: ! |

nance |F'urc:hase Order

stions ': | Copy 'i 'E',.J

Use the Help menu to display Application and Program Help, and to view installation and

application configuration details.

The Help menu commands include:

Search. This option displays the QAD Assist default search page.

Application Help. This option is available when your cursor is placed within a non-component
based field or screen. When you then select Application Help, field or procedure help is

displayed for the field or screen.

View Configuration. Opens a window that displays various configuration settings that cannot
be directly changed by a user of the QAD .NET UI. These settings must be changed by a

system administrator.

About. Display information about the version of QAD .NET Ul that is running, the time the
QAD .NET Ul was started, and the total amount of physical memory the QAD .NET Ul is
using. (If N/A is displayed, the operating system is not giving the QAD .NET Ul permission to

access system information.)
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Applications Area

Applications Area

File Edit Tools Workspace ‘Window Help

File Edit Tools ‘Workspace ‘Window Hel

‘1:} Applications

Click folders to opern—s || @i Ededins] |
#HT] Metrics [
(=% Customer Management |
. = Sales Orders/Invoices
_ Double click on any—s B0 Sales Order Meny
% ) Master Data orOgram to open T Sales Orider Maintenance
=8 Syshem Admiristration [ Sales Oider Browse
5 () Processes [@ Sales Oider Print
s TR =) Sales Drder Viewer

|E5| Sales Order Confirmation

=) Sales Dider Manual Allocations

|E| Sales Oider Auto Allocations

[& Awailable Kit Quartity to Ship

|E| Sales Order Repricing [+]
Ll ] [r |

*I Favorites

Select your favarite application fram the
Applications menu and drag it into this
window ta save it,

The Applications area displays the menu items for the QAD applications running in the
QAD .NET UI. When the system is installed, the default menu organization is automatically
loaded. Multiple screens can be open at any one time.

 Find programs based on one or more menu label keywords, program name, or menu number.
For example, enter sales to display all menu labels that include the word sales.

« Execute a specific program based on full menu label, program name, or menu number. For
example, enter Item Master Maintenance, ppptmt.p, or 1.4.1 and then press Enter to display
Item Master Maintenance.

» Execute a specific program based on a shortcut defined in the Name field of Menu System
Maintenance.

When typing in the menu search area, different screens appear as the typing continues until the
proper screen is located. This is called predictive text.
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Properties

File Edit Tools Workspace Window Help

'i:} Applications !j
[711 %] { ‘
'{ 1714 Salez Order Mai ]
EJ zm Sales Order Repricing L Findin Menu
57112 Sales Order Cost Revalu) (& Add To Favorites
4
B 7.1.13 Sales Order Credit Maint; Onen,
[@71.14 Sales Order Credit Inquir P
[@7118 Sales Order Credit Repor Design
[==EARL Sales Order Auto Cradi Popetties e
B 717 Sales Order Auto Credit £y, .
G 7118 Pamnlatar Gales Mrear Nalats ]

1.

s Gy s ga

% Sales Order Maintenance
S Purchase Order Maintenance

Right-click any
program and
select
properties

The Properties window includes two tabs, General and Program.
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Properties Options

Properties Options

&3’} Sales Order Maintenance Properties

=

General ‘ Program

]

“-r:'_'b‘ Sales Order Maintenance
rog

Key: 711
Alisses: 711, sasomtp +—— Program
Meru:  Customer Management [y e Cimic]
Number

URL:  gadsh//menu/invoke menu-key=a. 1 kmenuite...

o] 4 i | Cancel ‘ {

"%_‘} Sales Order Maintenance Pro pe rties

General | Program

Dornaint GMS EMEA - Demo [EUR)

Program: sosombp
UI Ternplate:
Desktop Wersion: 2109059

Wersion:

fDesklUp
Desktop |
Terminal

open with:

Select Terminal

GAD Enterprise Applications 2010

ok || canear ||

General:

L]

L]

URL. The QAD Shell URL for the program.
Key. The program number. For example, 7.1.1 is the program number for Sales Order

Maintenance.

Aliases. The program number and name. For example, for Sales Order Maintenance, 7.1.1 is

the program number and sosomt.p is the program name.

Menu. The menu item folder location.

Program:

- Domain. The current working domain and domain currency. If the specific program updates

data that applies to all domains.

Program. The program name. For example, sosomt.p is the program name for Sales Order

Maintenance.

Ul Template. If the user executing the program has been assigned a Configurable Screens
version of the program, the name of the assigned Ul template displays.

Desktop Version. Version details for Desktop.

\ersion. Product system version details.

Open with: Desktop or Terminal.
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Navigating Browses

Sales Order Maintenance
= GoTo ~ Actions »| L1l Copy =| =0 Print (& Preview | & attach
Sales Order: (> Order
Header Lines
B Headers = [, [ 2 > Fre [ 2 e B Defive | ST =
Header
Order; | Sold-Ta: Bill Te: Ship-Ta:
—— =
1 WSales Order Master
Sold-To . o .
x Actions = =) Print
earch
[5ales Drder - | [starts at - | Sl - |
Records per page: (100 - @ @
Sales Order A% SoldTe &% OrderDate & % Purchase Order
[l 10005 CE4000 0&/21 /2007
tyakalis 10006 CE4D00 06/21/2007
Orclat Date: 10009 CE4000 0&/21,/2007
. 10012 CE3000 0E/21/2007
Flequired Date:
Bromise D 10013 ce3000 OE/21/2007
e 10016 CE3000 06/21/2007
Dug Data: 10019 CEA000 06/21/2007
Performn D ate: 10025 CE 2000 R{22420017

Many fields display a small magnifying glass icon. This indicates that a lookup is associated with
the field. Click the icon or use the Alt+L keyboard shortcut to display the lookup. The lookup lists

valid values for the field.

A drop-down list is displayed when only a few values apply to a field.
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Navigating Non-Component Based Programs

Navigating Non-Component Based Programs

Dider B SeldTer CE4DOO BdTo CE4000 ShipTe CE4DDD

Regused Date. 6/22/2007 Marnat Cumency. EUR Langusoe us
Proenize Date: Daybook Set. 5LS Taxable H
Diuse Diate: E/22A2007 Chanred Favedt Price
PPPPP Diater Paoject Croch Tewms 300
Piicing Dishe: £/21/2007 Diglaw: Sie: EMEADEG

Frechase Clickes Cirdd T 00

Sales Dider. &) Oider
Headee L Tis

Screen NOVigO-Hon _— :E::.d-»..‘ ; S R L e T
Bar '

Because non-component based screens are a rendering of the character Ul, you can navigate these
screens using the same keyboard commands. You can also use mouse clicks to select fields and
enter data.

If the program opens in .NET User Interface mode, a navigation bar is displayed along the top of
the screen indicating where you are as you proceed through the program screens. For example, the
screen for Purchase Order Maintenance includes a navigation bar indicating the parts of a purchase
order: Header, Tax Info, Lines, and Trailer.

The Screen Navigation Bar option in the Desktop section of the Options menu (choose Tools|
Options) specifies whether your QAD .NET Ul client displays the navigation tool.
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Sales Dider 5010269 () Order5010269
‘o Lines  Tesiler
> » LineDetals » > Tax >
Headet
Order: 5010269 Sold-Tec BLU4000 LnFoe: Single
Sales Didet Line
Ln  ltem Mumber Oty Ordered UM
190900 10000 LT
Line Details
Desc: Standard Coolant Sales Acct| 4000
Loc: | Al s usAa Disc Acct | 4200
usD Cost: 0.00 Confimed ¥
Lot/Seriak| 2 Required | 6/10/2010
Oty Allocstedt 00/ Promised| 6/10/2010
Qty Ficked: 0o Due Date:| 6/10/2010
Qy Shipped: oo

Peitorm [ate:

List Price
100.00

Program Screenin Desktop (Ul) Mode

®  SokdToBCU40N0 (%) Bl ToB-CU4000
Org:
Dizcount Het Frice
100.00
| Mech 2 F
A3 Mech P el y<l
Credit Tesrns Int: 000
v Ship Type: bl
- UM Corvvession: 1.0000
» Congume Fest &

Dretad Alloc:

Here we contrast the QAD .NET Ul with the more traditional Terminal version in the prior screen.
Use point and click, tab, Next, Back or Header, Lines and Trailer Tab to navigate in the non-

component based QAD .NET UI.
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Program Screen in Terminal Mode

Program Screen in Terminal Mode

l Sales Order Maintenance x|
Order: ! Sold-To: Bill To: Ship-To:
Sold-To Ship-To
I
i Order Date: Line Pricing: No Confirmed: No
Required Date: Manual: Currency: Language:
Promise Date: Daybook Set: Taxable: No
Due Date: Channel: Fixed Price: No
Ferform Date: Froject: Credit Terms:
Pricing Date: org Inv: Site:
Purchase Order: Credit Terms Interest %:
Remarks: Reprice/Edit: No
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Summary

Summary
« You can display some non-component
based programs in terminal or .NET Ul mode

- Component-based programs display in .NET
Ul mode only

« A screen navigation bar is available for
some programs

Process maps let you drill-down on process
flows
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Objective

Objective

- Learn about the extensive help capabilities
of the QAD .NET Ul:

Character Ul Help

Application Help (F1 or Help > Application Help)

QAD Assist (Help > Search)

- QAD Guide Me

QAD Document Library
http://www.gad.com/documentlibrary/

1

1
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Benefits

Benefits

« You willbe aware of the different types of
help and how they can be accessed.
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Training Flow

Training Flow

INnfroduction
Navigation

- Application Help

« Programs
Browses

- Character Version
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Help in Terminal Mode

Purchaie Quder Maintenance % (

Ship-To: I

Enter data or press F4 to end.

| Purchase Order: Supplier:
Purchase Order Maintenance X
supplier ——— gy [ Fiold Help : Purchase orcer
Sk o | Pur Enter a number identifying an order or leave blank for
Birchase Order: [V system-generated number. If blank, the system creates
ﬁ — number based on the purchase order prefix and next pur
ERGLRRE VEReh order number maintained in Purchasing Control.
12 The system displays a warning if:
Order Date: 20010601
Bue Datet Ak 1 o You enter a purchase order that has already been p
B.?_{ly:r- acmioo 1f you modify the order, it may no longer correspol
ll 7 g' ‘230 the one sent to the supplier. You can update the r
e it o number to track additional changes.
Contract:
Contaet: 0 The order you specify was created in Scheduled Ord
Remarks:

Maintenance. Since different data is maintained fo

scheduled orders, you should normally maintain thesg

their own program.

Enter data or press F4 to end.

« The first time you press F2, a lookup browse displays if one is attached. If not, field help
displays first. Use lookup browses to view records available to specified fields. You can
choose a record to enter in the field. If you enter a value and press Enter, the list in the bottom
of the browse frame scrolls to the first record that matches that value. Use the arrow keys to
scroll through the list, then select the record by pressing Enter.

» Press F2 again to display field help. It describes a specific field and how it is used in the
program. Most updateable fields have field help. Display-only fields do not.

» Press F2 again to display procedure help. It describes the program and how it is used in the
module. Procedure help is not generally provided for reports, inquiries, browses, or control

programs.
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Help Menu

Help Menu

File Edit Tools Workspace Window |Help

@ Applications |_‘,‘ Procel Search | =
| Meru Sarch Application Hel =
= — ‘ # Go @ u = Print 4] Preview
-7 Collections 7
,. h’;l : P View Configuration
i Metrics
Send Error Report : ;
Customer Management P> He b atz P S
Supply Chain About
{7 Manufacturing Drder:% I’-J; Sold-To
FHT Financials ——
[#7) Master Data
{5 System Administration Sold-To

{1 Processes
FHT Administration
-5 Tools

Help

 Search. The Assistance Panel is available by selecting Search.
« Application Help. This option is available when your cursor is placed within a non-component

based field or screen. When you then select Application Help, field or procedure help is
displayed for the field or screen.

» View Configuration. Opens a window that displays various configuration settings that cannot
be directly changed by a user of the QAD .NET UI. These settings must be changed by a
system administrator.

« About. Display information about the version of QAD .NET Ul that is running, the time the
QAD NET Ul was started, and the total amount of physical memory the QAD .NET Ul is
using.
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Application Help (F1) for Programs and Fields

Application Help (F1) for Programs and Fields

‘J Help

i8[=) X

QEORIESHD

Sales Order
Sales Sub-Account
Salesperson
Selected

Ship via
Ship-To

Site (so_site)
Site (sod_site)
Sold-To

Sort Name
Standard Bill

Standard Pack

Quantity
(ord_mult_alt)

StanAdard Darl

&)

Sales Order

Enter a number identifying an order or leave blank for a system-
generated number. If blank, the system creates a number based on the
sales order prefix and next sales order number maintained in Sales Order
Control.

The number uniquely identifies a specific order or pending invoice and its
line items.

QAD Document Library | Support

When your cursor is in a program field, press F1 or choose Help | Application Help.
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Application Help (F1) for Functions and Fields

Application Help (F1) for Functions and Fields

o
QORLSS O
[ BlournalEntry.Create r Field Help -\| |ﬁ]
Journal Entry Create |~

Use Journal Entry Create (25.13.1.1) to manually record transactions for financial daybooks.
However,.

A journal entry, or posting, is the basic transaction in the accounting system. In its most simple |~
representation, a journal entry is a transaction composed of multiple posting lines, each of them
associated with a GL account and an amount. Nevertheless, in most cases, journal entries also
have other dimensions, represented by analytical codes.

Define the transaction posting lines in the grid. A posting line can be composed of multiple sub-
levels containing additional posting information.

The level 1 posting line contains fields for the GL account, sub-account, cost center, journal entry
description, base currency, and debit and credit amounts in the base currency.

The posting grid can automatically display additional level 2 posting lines and fields, depending
on how the GL accounts used in the transaction are defined, such as fields for:

o Transaction currency | .|
I b4
| | I

[«

[v]

When your cursor is in a component-based function field, press F1 or choose Help | Application
Help.
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QAD Guide Me

QAD Guide Me

Sales Order Maintenance X

® GoTo ~ + Actions = | Copy~ (= Print '\ Preview # Atach

Customer &)  Order
Header Lines
D Header B (i B > > >
Header
Order:| A|  Sod-To Bill To

Enter a number identifying an order or leave blank for a

Sold system-generated number. If blank, the system creates a Ship-To
number based on the sales order prefix and next sales
order number maintained in Sales Order Control. More...

Edit

The QAD Guide Me feature provides immediate mouse-over descriptions of fields in both
component and non-component programs. The feature is disabled by default.

Note Field help for non-component based programs is also displayed by pressing the F1 key
when the cursor is positioned in the field. Click the More... link to display an extended description
of the field, and the Edit link to edit this description in Field Help Maintenance.

Note The Edit option is only visible for users who have access to Field Help Maintenance.
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QAD Assist

QAD Assist

O Heyy (=[]
QORISR E

“"3QAD Search

Program Help | Field Help | All

3]

QAD Document Library | Support | Copyright

Choose Help | Search to use QAD Assist. QAD Assist provides a searchable HTML interface
offering links to program help and field help.

You can search for single terms (such as ‘Sales”), phrases (such as ‘Sales Orders’) or complex
terms using operators (such as ‘test AND system”). The panel stores default fields, which you
define during deployment, which do not need to be specified when searching. The following oper-
ators are supported by the panel:

AND, +, OR, NOT, -
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QAD Document Library

57

QAD Document Library

QeERSESNH

Search

515

o
o |-

(QAD Enterprize Edition

ndard Edition

providing innovative enterprise software

Select Language

and services for global manufacturers

Tips on Using the QAD Document Library

The Document Library contains online and PDF documentation for all QAD products. To learn
more, see  QAD Document Library Overview.

How to Find Content

1 Use the Navigation Tree on the left, which lists content grouped by QAD
application and book type.

2. Use the Search, which finds al documents with your search terms and lets you
refine the search by module, applicable certification, book type, product sufte, etc.

What Can | Do with the Content?

Once you find the content you want, you can choose icons on upper right of page as
shown below:

1} B | @

The QAD Document Library (http://www.qgad.com/documentlibrary/) includes QAD user guides,
administration guides, installation guides, training guides, and other materials.

Click the QAD Document Library link in QAD Assist to access the library from within QAD

Assist.
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Summary

Chapter Summary

Help includes the following features:
- Character Ul Help

- Application Help (F1)

- QAD Assist

- QAD Guide Me

- QAD Document Library
http://www.gad.com/documentlibrary/
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Exercise and Knowledge Check

1 Launch Purchase Order Maintenance in terminal mode.

Press F1 in the first field of the purchase order? What is displayed? Press F1 again. What is
displayed this time?

2 Go to the Sales Order Maintenance screen and select Help | Search. What screen is displayed?
3 Do asearch on the word Sales. Drill down on Sales analysis. What is displayed?

4 Goto Journal Entry Create and hit F1. What is displayed? Note the differences between a non-
component based help and component based help.
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Objective

Chapter Objectives

« The objective of this chapter is to describe
program types and program features in
QAD Enterprise Applications.
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Benefits

Benefits

« You willbe able to identify different program
types and will be familiar with some basic
Enterprise Applications program features.
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Training Flow

Training Flow

 Introduction

+ Navigation

« Application Help
- Programs

« Browses

« Character Version
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Program Types

Program Types

« Maintenance Programs

« Inquiry and Report programs

« Browse Programs

- Transaction Programs

- Utility Programs and Control programs
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Maintenance Programs

ltem Master Maintenance X|

Maintenance Programs: Component- and Non-Component based

# GoTo ™ Actions ™
Product Line: (1)
GL Account Create ¢

| Copy ™ L.‘_;,‘.JPrinl v Preview @ Atach

ltem Planning Price

AvtodManual
Intercampany Accaunt

Fired Intercompany

b it BB H GoTo ™ Actions = 3 Taools ‘! & Atach | TQ.J Print &) Preview
Altachments
Item
Item Number: GL Account ! | |
Unit of Measure: Drezcription ! % |
GL Type ! Standard Accaount - ! Systern Type ‘
ltem Data Active v Budget Group 1 L | ¢
Prod Line BudgetEnabled V| Category |_A9_S_E_t_
Status:
Design Group: Posting | Currency ” Analysis " Report Link " Banking || ash " Defaults
Added:
s laanion.Data—
| Balarice Sheet Accovint - | Diebit/Credit ‘ Diebit A |

| b anual

The Item Master Maintenance and GL Account Create Entry are examples of maintenance

programs that update the database directly when the record is entered and saved.

In the case of non-component maintenance programs changes to the record will be made in the
same maintenance screen, where as in component based maintenance programs changes are made

in the Create, Modify, or Delete maintenance screens.
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Inquiry and Report Programs

Inquiry and Report Programs

ltern kaster Inguiry - 572452010, V\| I
n Item Master Inquiry 05x24/i
- X
QAD Itern Cost Report |Item CostReport - 5i2452010 1.

Site Description Line Description
Ttem Number: 010 pinh

Site: 10-15-100 UTtrasound Mfg Site 10 Finished Goods

01010 EA Medical Ultrasound
Prod Line: 1C

Added: 01 Cost Set Material Labor Burden overhead
Design Group: PR
Promo Group: ME
Current 225.71 19.34 0.28333 Q.00
13/01/10
ABC Clas standard 225.71 19.34 0.28333 0.00
Lot/Serial Cantroys o110
59t
Locatic 01011 EA Supplies Kit
Location Ty
Auto Lot Number Cost Set Material Labor Burden overhead
Lot Grot
Article Numbe
Current Q.00 0.00 Q.00 0.00
13,/01/10
Carp Commn Coc Standard 0.00 0.00 0.00 0.00
Ship Weighs 110
Freight Cla:s
01020 EA Implantable Ultrasound
Cost Set Material Labor Burden Owerhead
Current 144.81518 25.09176 0.36372 0.00
13,/01/10
Standard 144.81518 25.09176 0.36372 0.00
13,/01/10

Inquiries and reports retrieve and display operational database records. Inquiries are primarily
used to answer specific questions. Reports usually provide more detail and are printed for a range
of data records. You select data by entering a specific range of criteria, such as item number or

date.

Typically, inquiries are viewed online and reports are sent to a printer or file. However, you can

also print inquiries and view reports. In addition, other output options, such as e-mail, are

available.
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Component-Based Reports

GL Account List X |

< Tools | &b Print » Preview  Variant =

Repon Vaniants
Fiter

GL Account <2
05000 y,

FACTORYDEFAULT bl

Component-Based Reports

GL Account List

- QAD

GL COA Element TySys Type DebitCredt  BalancefPEL  Auto/Manual  Analysis Type
Account
05000 STAMDARD DESIT BIALANCE MANUAL Hane
05600 STANDARD DEBIT BIALANCE MANLIAL o
05610 SYSTEM RESULTCURRENTYEAR CREDIT BIALANCE AUTOMATIC  None
05620 SYSTEM RESULTPREVIOLISYEAR CREDIT BIALANCE AUTOMATIC  Mane
03000 STANDARD CREDIT BIALANCE MANUAL Hone
03100 STANDARD CREDIT BALANCE MANUAL Hane
10000 DEBTORCONTROL DESIT BIALANCE AUTOMATIC  Maone
10100 DEBTORDCCUMER DESIT BALANCE AUTOMATIC  Mane
10200 QOPEMITEM DESIT BIALANCE MANUAL Hare

Server Output Processing 10500 DEBTORCONTROL DEBIT BALANCE AUTOMATIC  Naone
10600 DEBTORDOCUMER DEBIT BIALANCE AUTOMATIC  None
11300 STANDARD DEBIT BALANCE MANUAL Hane
12200 BANK DEBIT BALANCE MANUAL Hare
12204 BANK DEBIT BIALANCE MANLAL Mane
13000 STAMDARD DESIT BIALANCE MANUAL Hare

Component-based reports have multiple output options, including viewer, printer, and export to
PDF, XLS, and DOC standards. The report output is easy to customize, and you can create an

extensive set of reports with unlimited report variants for many output types.

You can run a report immediately, or choose to schedule it to run later. In this case, a pop-up
window opens to let you enter details for running the report at a later date.
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Transaction Programs

Transaction Programs

Purchase Crder Returns % I
M GoTo ™ Actions | L] Copy 7| I.E,',J Print x| Preview | § Aftach I

Ordercall07 —‘
Journal Entry Create X

Pirchsse O ca.”m_!“g.n To_ - Actions = 2 Tools '! & Atach ! @J Print s Preview

r Atlachments
RTV Nbr:| 1234
Weal [a0io][ 5] Posting Date [o5728/2m0 ~|
Sh\p—From:: MD]D[ Daybook Code |JE ¢ 000000001 Layer Type | OFFICIAL ] Save fs Template
Ship-T°1:_#_t_1_{_)P_ Dezcription | Joumal Ertry ‘ Template Code . 7] Replacement
Original Posting [ B ¢ equence Mumber | 000000000, £
Frphaas | Sequence Mumber
GL Account 4 Sub-AccountC ¢ CostCe ¢ D escription 4 Trans Curr 4 TC Debit 1 TC Credit 4
1100 Expense uso 1.000.00 0.00

0.00

Transactions programs control and record activities related to business documents such as sales
orders and invoices. An example of a transaction is receipt of a shipment for a purchase order
using Purchase Order Receipts or Returns. Enterprise Financials transactions programs include
Customer and Supplier Invoice, and Journal Entry.

Most data in the database is transaction data. Every day, sales orders come in, purchase orders go
out, and work orders make demands on and create material for inventory. These events result in
transactions, which are stored in transaction tables. In contrast to control programs, transaction
tables are constantly updated by users of the system.
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Control Programs

Control Programs

Purchase Order Returns % l
M GoTo ~ Actions = | .| Copy ~| '8.1 Print s Preview § Aftach
Order:cal107 @ Purchase Order:ca1107 _@) SH\p—Froml:dD‘IDIi
Purchase Order: calll7 Sunnlier dr100 Statius Ffiective | 5247010 -
BTV Nbr| 1234 | Work Order Control X
‘“ GoTo ~ Actions 7| Ll| Copy ™ é_',) Print s Preview
Ship-From:| MD100 =— — =
Ship-To: ..dﬂ 00 Auto WIO Numbers: ¥
" NextwiONbr| 1022

\work Order Comments:

Routing Comments:

Move First Operation: ¥

Control Data

When you implement a module, you enter data that the system uses later to control how the system
interacts with users and with the database. This data is stored in control tables. Control tables
enable you to adapt the system to your environment. The data and settings in these tables
determine how certain programs are displayed, the numbers assigned to transactions, the GL
accounts for particular transactions, and so on. When you can manage a typical manufacturing
function in more than one way, control programs let you establish a preference.
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Go To Function

GoTlo for Non-Component and Component- Based Programs

Sales Order Maintenance *

W GoTo - Actions *| || Copy ™ LE,',J Print » Pr
PO Maint (\_f} Order:
Add Link
[ Header = [ | 2| [ |
Header
Order: [ GLAccount Create
& GoTo - Actions * 77 Tools " & Btach ' L.E'.J Print & Preview

Related Views

3

3

Create New Budget Group

Create New GL Account Unit of Measure
Ly

Active v

Budget Group
Budget Enabled

The Go To menu for non-component based programs such as Sales Order Maintenance displays
the Add Link option. Use Add Link to create links to other programs using User Tool Maintenance
(36.20.4). The links you add display on the Program Links drop-down

The Go To option for component-based programs displays Go To options and Related Views.
Related Views are commonly used views and reports that apply to the record you are currently
working with.
Go To behaves differently depending on whether the current field has data in it:

« |f the field has a value, Go To invokes the View activity.

- |f the field is blank, Go To invokes the Create activity.
All of the related views take the record you are currently using as the base for the information.You

can simply click the Go To to see the Create New Budget Group or Create New GL Account Unit
of Measure.
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QAD Messaging

QAD Messaging

File Edt Tool: Workspace Window Help

| sales cicer man
55 Sales Ordes Maintenance

| Mezzages —Inbox % |

* New | =+ Reply 1§ ReplyAll =% Forward | ™™ Move 3§ Delete < Frint | o Refresh | ¥ Hide Details

Filles on (From ~| Filer

——— ) Date. v | Subject

Deiouh MFG User  25/05/201010.34.05__ Saves Dider Marienance (10001)

Defaull MFG User  25/06720M01032 26 5 ales Drder Maintenance [ 000000

G Uoen 102314 5
G Uset 102844 Puich L 5]
Defaul MFG Uiser 10:27:53  Pusch L 505]
( 1
From: rmig

To: Defaut MFG User

Subject Sakes Order Mantenance [10001)

- Please review and approve the following sales order:

{ Sales Order Maintenance (10001)

The QAD .NET Ul includes a messaging capability so that you can send messages and workflow
information to other users of the system. When using programs, browses, inquiries, and process
maps, you have an Inbox on the Right side of the application area for sending and receiving
messages. You can also send program or browse workflow messages, which include links to
programs or browses, by choosing Actions|Workflow when using a program or browse

To Send a Message

« Click the Compose Message icon.

message.

L]

MQAD

In the To field, enter the user 1Ds or names of the users to whom you want to send the

In the Subject field, enter text indicating the subject of the message.
In the content area, enter or paste message content.
Click Send to send the message (or click Cancel to cancel it).
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Workflow

0 GoTo ~ Actions ‘:i L Copy ‘: 'E'J Frint » Preview i @I
alez Orderd B Newxt () Order&UTO2

eader Line 9 Back [} Journal Entry Create -

Header MNext Record | Go Ta " = Print (8] Preview

Previous Rer
Inzert Workflow Name | Joumal Entry Create ¥ Load I [ Store I
il E workflow i %
o : Role |EmployeeNoti[y -
Orde - E-mail
Rlequire Export Data Fequired Activity | Review ¥
Promise D ate: Feturn to Sender x| &g =R
D Date: , QM User 202PM
Sales Order Maintenance (AUTOZ)
Iristuagtions P Sales Order Maintenance (AUT02)
C t L YNewMessage =% Reply i# ReplyAll = Forward $§ Delete
aomponent
R From: | QM Lser
To: gmi
v
Subject | Sales Order Mamienance [AUTOZ)
Sales Order Maintenance (AUTO2)
MNor-Component —

Workflow is available for both types of program and is visible as an Actions menu option for non-
component based programs and as a Tools menu option for component-based programs. When you
click Workflow in a non-component based program, the system creates an e-mail message for
another system user, with the current screen as an attached link. This e-mail is then posted to the

user’s Inbox.

In a component-based program, you use the Workflow object dialog to specify the name of the
workflow, the role of the recipient and activity they are required to perform on the link.
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Copy

Purchate (rder Marteneres
- JeTe * Agwyen * Capy * 2 Pree 5 Prevew
Hlanded Lias 1
* Hoodw » [ P Vi > > > »
Heade:
Puschaie Dulee 1000 Supcle:| IND So-le D
S Yol
Fape e
Fis Fomat
T0Man Ghmst — S M
Frama: wsader
Purchase Order: 1000
suppifer 310
Dwop L N6 Ship-To: 12000
Erane:  suppl e
Unteel 2 abas Page Inz,
10 Mmatn Street
Detas <hicago
e 1 o061
Dodes Date SE2008 Prce T uniTed States
Des Dite: VET0R D T frane:  3hip o
Zh Plam
By (L1t o 21 ventura Blvd,
e M Liw Lo angeles
i
Sreaiiob Dartocd St AP 0210
united states
Corwe Puleeano: petalls
o o Orcder Date /002000
rd 5 Price Tol
confiming true
Rarnabr d iy ;,H-.l:.g, false

The Copy menu is only available for non-component based programs and lets you to copy the text
of the current screen to the clipboard, or copy an image of the current screen to the clipboard.
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Print

Order114

Header Lines Tiader
B Header B Detal:
Header

Suppber
Acme Supply Co.
1 Clanidge Diive

Verona

Urdted States

Dretails
Order Dater 23/07/2003
Due Datec 30/07/2003
Buyer
Bill T MD100
Salesilob:
Contract:
Contact:

| Purchase Order Maintenance x|

B Taxinic

B Logitics B Defvery B EAS B Concignmenl B Comments

Puchase Order: 114 3

) S 3000 Flaim Ta. bAD OO
i Print ﬂﬂ
Printer
Narme:
Status:  Ready
Type: Amyuni Document Converter 251
Wheree  LPTT:
NJ 07044 Comment: I Print to file
i~ Print range: Copies
o« Al Mumber of copies: i'\ a‘
" Pages from: [0 to IU
Price Thi: [ P Colate
. € Selection 11
Disc Tht
Ln Dize:
T
% o
Daybook Set: defap Credit Terms: 2/40PROX 000
Froject Ertered By: kie
Fequested By

® GoTo ™ « Actions ~| L. Copy ~| & Print =l Preview | # attach

() Purchase Drder114

The Print menu is common to both types of program and prints the current screen to the default

printer.
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Attach

Attach

Sales Order Maintenance *
‘# GoTo ¥ Actions W | | Copy ¥ S print _{? Preview | A2 k.
= - hed & “ @ sdes order:10004 (1)
Sales Order 10004 [1 { Order:10004 |3
SR RIC M ® & Order:10004
Header Lines 1
P Header » [ > r » Fieigh > £ P Defve | 2 | g
Header
Oider.| 10004 A SoldTe CU2500 Bill To: CU2500 Ship-Ta: CUZ2500
Sold-To Ship-To

Attach lets you attach any type of document—such as a Microsoft Word file, graphics file, or
PDF—to a record within the application. This integration ensures that all required documentation
is immediately accessible when needed. You can attach and view any type of file if the

corresponding viewing software is available on the client. This is both applicable to component
and non-component based programs.
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M GoTo W
Sales Order:1000 @
Header Linez =

P> Header
Header

Order: Hﬁ};
=]
Sold-To
Fiosy's Bike Shop :

Sales Order Maintenance

Actions v| _,;_ Co
Mext

Back

Mext Record
Previous Record
Inzert

“wiorkfl o

E-mail

Export Data

Record Program Actions

s = B

e " Options ™
Comment

Purchase Order Maintenance

Frame

+ I

next

submit
submit
submit
submit

oo oa oW oW

Target Field

po_nbr

po_nbr
 wend
_ship

po_ord_date

Comment

The Program Export File function is a test utility in the QAD .NET Ul and is available in the
Actions menu for all non-component based programs. This function lets you record your actions as
you complete an application process and save the recorded actions to an . XML or .XLS file that
you store locally. You then execute the saved .XML or .XLS file in the Execute Document Import
function to reproduce the recorded process on screen. Saved files can be exported for testing to
another QAD .NET Ul environment, or imported into the current environment.

1 Launch a program.

2 Choose Actions|Export Data. An Export Data screen is displayed (minimized) on the screen
while the system is recording your user actions. Each user action is immediately listed in the
Actions grid of this screen, and you can pause, name, and save the recording in this dialog

3 Enter a variety of actions for the program. These actions are now recorded. The Export Data
dialog lists the actions, frames, and fields being recorded.
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Saving and Browsing Drafts

The Save as Draft and Browse Drafts options are available for component-based programs only
and must be enabled in Change System Settings. When Save as Draft is enabled, you can save

Saving and Browsing Drafts

Actions =% Tools = # Aty

Undo

H Save

k" Save and Create
Save As Draft

# View

= Modify

*  Delete
Transient Create
Transient Modify

Reverse

Reversing Journal Create

Transient Reverse

E Browse Drafts
Properties...

Exit

Ctrl+Z
Ctrl+3

Ctrl+B
Ctri+0
Ctrl+D

-

Alt+F4

| Systern/User setting x‘

o (-, Actions = 7 Tools 7 \.-‘? Print « Preview

Active ¢ Setting
,
L Business Logic Version Checking
Field Security
v Automatic Save of Gnd Settings
v Automatic Save of Last Used Browse Settings
v Allow Save of Grid Settings
Il Uzer-Defined Fields
v Event Publishing
v User Interface Customization
v warkflow
Ld

Enable Persistent Cache,

selected records without completing all the validations required to ensure that the record is

complete. You can then finish adding data to the record at a later time by using the Browse Drafts
option to find the incomplete record. Only the following subset of components provides the ability

to save unfinished records as drafts to be completed and approved later.

L]

Banking Entry

Business Relation

Petty Cash
Customer

Customer Invoice

Finance Charge
Journal Entry

Supplier Invoice

Supplier
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Summary

Chapter Summary

In this section you learned about program
types and menu features for both
component and non-component programs.

Exercise and Knowledge Check

1 Sales Order Control is an example of what type of program?

2 In Sales Order Maintenance, select the GoTo function. Add a link to the Sales Order Browse
program sobr009.p.

Open up a sales order and GoTo the Sales Order Browse.

3 Display a completed sales order in Sales Order Maintenance and send the sales order to your
User ID by using the workflow.

4 Create a document in MS Word. Save it to the c:\ drive and attach the document to a purchase
order.

5 Select GL Account List, run the report, and send the output to a printer.
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Chapter Objectives

Chapter Objectives

« The objective of this chapter is to infroduce
browses in the QAD .NET Ul.
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Chapter Benefits

Chapter Benefits

« You willbe familiar with the different types of
browses in the QAD .NET Ul.
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Training Flow

Training Flow

INnfroduction
Navigation

« Application Help

« Programs
Browses

« Character Ul
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Introduction — Browse Topics

Infroduction

+ Browse Topics
- Look-up Browses

Power Browses
Filters and Operators
Component-based Browses
Favorites
Grouping
Column Options
Managing Filter Fields
Browse Reports
Quick Search
Operational Metrics
Excellntegration and Browse Excel output
Using the Chart Designer
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Lookup Browses

Lookup Browses

=

FlCust

r Master
Sold-Ta:
el 7' Actions ¥ é_b Print
Search
iCustomar e | |starls at - | | ,(O[ 0‘] - |
Records per page: |j oo vJ T;‘) @ @ {
Customer A % Sort Name 4 W Telephone % 7 City “ W State
w/a-Mart Bentanvile
10C100 MediLogic Bridgewater M
10C1002 Houston Automotive Grop Houston TH
10C10028 Houston Automotive Grop Houstan =
10C1003 Pacific Health Care Systems Loz Angeles Ch
Line Pricing: | 10C1004 Price Chopper Schenectady MY
Marual 10C1005 Rockland Industrial Company Rockland MJ
B bookis T0IMTCUS QM - USA Division East Hanover ]
t
Fooonme 11C1000 Cipacath Technologies Inc. Kikland ac
Efiannel 11C1001 Chiro Foods imited Edmanton AR
Project: 11Cio0z2 General Motors of Canada Oshawa

Return the value selected to the active field in a calling program. The lookup browse has limited
functionality. Look-up browses cannot filter, graph, or print data

In the example, when you select the lookup Sold-To in Sales Order Maintenance, you launch a
lookup browse of Customer master.
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cliong

[sol-Ta

Yiewing 1-15 of 15

SaWO?

10003
10009
10010
10011
10012
10012
10004
10005
test10

Sales Order Browse *

Power Browses

% Actions ~ ‘.,‘P!'.J Print

Add to Favorites ki

Records per page: | 100

cul1500

cul1500

Cu1500
Cu1500
Cu1500
Cu1s00
Cuzs00
Cu2s00
Cuzs00

0
Ao
2
2

0

30

210.
L1

;u/'

]
]
]

@ Chart Designer | € Refresh = | Mew # Edit
Pl3) - |+ x Clear All

1
2

1

| P@e® @

SoldTo £ ¥ QuantiyDpen & ¥ Line & 7 ltemMumber A 7 Status & 7 Unitof Measwe &7 Quantity Oidered & 7 [
1]
i
il

10-10000-001
10-10000-001

1N WL

FT 100
FT -10.0

ET 20

|Sa|es Order Maintenance | Sales Order Browse J‘i|

& |

[ Exportto 05V
[ Exportto Excel

Exportta PDF

Actions L.E",.l Print * 7 Addto Favorites i llg Ch @ Chart Designer | ca
|| AR [
Records per page: | 100 - -I:';

okl

E-rnail
TRANST
TRANSZ

Ad-To & 7 Status & 7 Line & 7 ltemNumber &7 Unito

—C1000 1 02200 E4
30C1002 1 02200 EA
20C1000 1 02200 EA

A power browse can filter, sort, print, and graph data. Any column can be sorted. The first ten
columns can be filtered.

Navigation

» Use the navigation buttons in the top left (1) to move through the records. The buttons from
left to right move to the first set, previous set, next set, last set.

» Use the Records per page drop-down to determine how many records display at one time in
the browse. The default value can be set using the Rows Per Page setting in Tools|Options.

» The Max Browse Records field in User Options Maintenance does not apply to browses in the

QAD .NET UI. Use Tools|Options in the .NET UI.

» Attempting to display a large number of records at once can adversely affect performance.
Instead, use the Search conditions to focus on the specific records you want to review.

» Drag columns by their headings to rearrange the display.
» As a shortcut, instead of clicking Edit, you can double-click on the row that includes the item.

Sorting

« Click Clear All to clear browse results.
» Any column in the title bar can be sorted.
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« Click the heading to sort ascending order; click again to sort in descending order.

« Columns that cannot be sorted are generally non-indexed fields. Sorting by such fields
degrades system performance.

- Blue underlined text indicates values for which you can drill-down.

« Use Browse Maintenance to set the default sort order for the multiple sort orders for the
multiple columns in a browse

« Right-click any value to display associated links: either a more detailed browse, a related
program, or an external Web page.

Actions

By selecting the Action menu (2), you can export the browse to .CSV, Excel , PDF or a report. In
addition you can email the browse or include it in a workflow.
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89

Filters and Operators

Sales Order Browse |
Actions ',‘:',r Print

Search

 Add to Favorites

SoldTo slatts at

_:—ﬁustomer [bem
Deseription

| D [te
5| Expifes

Al

W Guartity Open & 7 Line &7 _ltern Nurnber 47 Status & 7 Unit of Measure & 7 Quantity Ordered 3

-

Ml 1 @ Chart Designer

/.__31 2| -

Records per page: 100 .

& Refresh = | New ¢ Edit
9000 @

Sales Order Browse

Search

Actions ¥ @J Print © [ Add to Favorites i ] att Zﬁ Chart Dezigner ; € Refresh ': | Mew , Edit
;é’l;ﬂd"TU - | | starts at ,'JE] - | + X Clear All
— equals ——— — § P
Wiewing 1-15 of 15 ot equals 5 per page: | 100 hdl| i) w @, ») %)

Sales Order %W Sold

containg
13nge
arts at

en < W Line & 7 ltem Numnber

A W Stdus £ ¥ UnitafMeasure © ¥ Quantity Ordered

10009 cub& greater then 10.0 1 1010000001 FT
10009 15 ::m‘ha” 0.0 2 10-10000-001 FT
10010 CUASis rot rul 20 1 10-10000-001 FT

Filtering. If stored search criteria exist, you can select one by name from the drop-down list at
the top of the search criteria (1). This sets up the filter criteria (2) to produce preconfigured
results. Otherwise, the search fields display with a default configuration. Refine the search
using combinations of filters and wild cards (*, and “.” for Financials browses). Click the + and
X buttons (3) to add and remove search filters.Click Clear All to clear the browse results.

1

Search Operators. The various operators includes equals, not equals, contains, range, starts at,
greater then, less than, is null, and is not null. When an equal sign is displayed next to the field,
you enter an exact matching value.

To refine your search further, click the plus (+) icon to add another search row. You can add as
many rows as needed, each with different search values and operators. If you choose the range

search operator, the second search box is enabled for the ending value of the range.
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Component-Based Browses

Component-Based Browses

‘Supplier Invoice Browse for Ma_. =

Actions = (= Print 'y Add to Favorites | (s [® ChartDesigner | €@ Refrash = = Stored Searches -
Search10)
|Suppler Code - || equals - Pl - | + x search | [ Clearan |
[Business Relation = | [equals - S - PR
[Retarence v | [equat - [2] - + %
[aa v | [scuste -] [=] - + x
[Daybock Code | equals - Pla]- | * x
[Voucher | equas = Ala)- | + x
e T — ] = T L T
Viewing 1-7 of 7 Records par page: 100 @ @ @ ® | O
Supples & 7 BusinessRelaonCode &7 InvDate ~ 7 Reference % TCBalnce & ¥ Cur & ¥ DusDate & W Descrption &
EURDOT 11/02/2010 Fi Supphes 120000 EUR 12/31/2010 Fr Supphes AFEURODT
A2004 Subcontiactors Inc. 11/02/2010 SubCont 2455300 USD 01/31/2011 SubCont AZ004
42001 Carbon Frames 11/02/2010 CarbFrame 3340000 USD 0173172011 CarbFrame A2001
£2002 Tube City 11/02/2010 Tubes 78.930.00 USD 0173172011 Tubes A2002
42003 100% Pusre - US 110242010 Aplr_US 40.980.00 USD 0731/2011 Apls_US AZD03
42003 100% Pure - US 11/02/2010 Aplrv_US -2,000,00 USD 0173172011 Aplrwy_US A2003
A2005 Cerazon 11/02/2010 COR -3,000.00 MM 01/731/2011 COR A2005
Summanes:
Sum =194,122.00

Component-based browses are launched when you view, modify, or delete a record created with a
component-based activity. For example, Supplier Invoice View (28.1.1.3), Supplier Invoice
Modify (28.1.1.2), and Supplier Invoice Delete (28.1.1.9) all launch browses, in which you select
the record on which you want to perform the activity.
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Sales Order Browse X |

Browses as Favorites

| 10010

10011
nmz
100039
1nmz2

Sales Order

CU1500
CUA500
CUA500
cul500

U500

Actions T @,} Frint ' Add to Favorites I Mg Chart @ Chart Dezigner I @ Re
Search [2)
[SoldTa +|equals | [ cutson Pl - |
| Quartity Open > ‘ |greater than - ! ‘ 0]« |
“iewing 1-5 of 5 Fecords per page: |1_D_U—v| \:1) @

4+ W SoldTo &% Ouantity Open & 7 Line & 7 ltem Mumber ~ 7 5

20
an
10.0
20

10-10000-001
10-10000-007
10-10000-007
10-10000-001
2 20-10000-001

Saving to Favorites

Click the Add to Favorites button. The browse is saved to your Favorites area and named based on
the name of the browse. If it is the first instance you have saved, the browse name in the Favorites
area is the name of the browse. If you save the same browse again, a (2) is appended to the name in
the Favorites area. Once you have saved the browse to the Favorites pane, you can rename the

browse and organize it in the same way as other items saved in the Favorites pane.
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Re-Naming Browse Favorites

Re-Naming Browse Favorites

J Sales Order Browse *

Actions T @ Frint ° © Add to Favorites

| Mamu Search ‘

iﬂ@ Sales Order Menu |:|
77 Custamer Schedules Setup Menu
{7 Sehedule Processing Menu
Euﬁ Containerization Menu

EI-@ Shipment Processing Menu

Search [2]

sile  Edit Tools ‘workspace

Window  Help I

-

E-iﬁ Legal Docurments Menu "r_a Rename Menu Fearclr |
15 Sales Quotation Menu 8l change Icon 4 47 Sales Drder Menu E|
) Invaice Menu & Remove [#H{ 7] Customer Schedules Setup Menu P
B Sales Order Reparts Menu auto Start #7) Schedule Processing Menu | = |
T — [#4=) Containerization Menu =5
2 ealopse Henus #=) Shipment Processing Menu
Open [#7) Legal Documents Menu
Design ) Sales Quotation Menu
FHT) Invoice Menu
Fropetties

[#7 Sales Order Reports Menu

U1500 Erowse]

3

Re-Naming a Browse

1 Right-click the browse.
2 Click on Rename.

3 Enter a new name for the browse.
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Grouping Results

Grouping Results

i -
100 i

Viewing 1-100 of 303 Records per page: |

+ Description: 1000 (1 itemn)
= Description: 1001 no sub-acct (1 item)
= GL Account:1001 (1 item)

+ Sys Type: (1 item)
+ Description:1044 Draft Accepted (1 item)
+ Description:1044 Draft Allocated (1 item)
+ Description: 1044 Draft For Collectio (1 item)
+ Description:Accounts Payable 1 item]
+ Description:Accounts Payable DM [1 item)
+ Description:Accounts Payable SPP (1 item)
+ Description:Accounts Payables Acct (1 item)
+ Description:Accounts Receivable (2 items)
+ Description:Accounts Receivable Acct [1 item)
+ Description:Accounts Receivable EUR (1 item)

Right-click and select Group to group data by column type. The grid displays a summary of the
column data, with the different elements sorted into groups. Each group in the list can be expanded

using the plus sign next to the group.

Add other columns to the grid to create a group hierarchy. Group options are saved automatically
in your last used settings, and can be reused when you open this browse again. You can also save

these options as a stored search.

To remove the split, select the bar icon in the second panel and drag it back to its original position.
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Summarizing Results

Summarizing Results

Role Mame &%  BCBalance ¢ W Type & W Subdcct &7 SCBalance & W

<200.00 Imvoice 10 200,00

21000 Inveice 10 210,00

-100.00 Irvoice 10 -100.00

20000 brvoice 10 200,00

12500 Irvoice 10 125,00

433500 Invoice 10 495500

-600.00 Irvoice 10 500,00

-100.00 Irvoice 10 -100.00

22000 lrvoice 10 -220.00

40000 Irvoice 10 400,00

-100.00 Irvoice 10 -100.00

10000 Invoice 10 -100.00

-200.00 Irvoice 10 -200.00

11000 Irvoice 10 110.00

500.00 Irvoice 10 500,00

1.000.00 Invoice 10 1.000.00
Sum = -3.260.00
Count = 17
Average = -544.71
Mirwnum = -4,595.00
Maximum = 10000

The Summary right-click option lets you display summary information, depending on the column
header in which you have clicked.

You must be able to view all the records on the screen page to enable the Summary option. If there
are more records than can be displayed, set the Records per Page field to All.

By right-clicking the BC Amount column in the results grid for Supplier Invoice Browse, you can
display the following summary information:

Sum. Displays a total sum of the invoice amounts
Count. Displays the number of invoice records
Average. Displays the average of the invoice amounts.
Minimum. Displays the lowest invoice amount.
Maximum. Displays the maximum invoice amount.

Note You only see meaningful results if the operator you choose applies to the data type. For
example, applying the average operator to a date column does not produce a meaningful result.

Minimum and maximum are useful with dates, and summary and average with numeric fields.
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Column Options

Sales Order Browse *
Actions T @,} Frint ©  Add to Favorites | g Chart @ Chart Dezigner I e Refresh 'I j Mlew i’ Edit
Search : - - -
|Salas Order - ‘ |slalls at - | | j-)! .r] - | | + X

Viewing 1-17 of 17

Records per page: i1DD B

e

2 —Sates¥rder
10019 CE4000

Actions © [.E';,l Print °  Add to Favorites

4 W So0idTo &7 Status &7 Line v % tem Numbe &7 Ln
Autosize Columns

Card View

_
Group By Line
Show Group By Box

» I |Sales Order ':1 |;t;tsiatr | |: I

Vi*g 117 of 17 Rect

kg dﬁ\tofMI%sua 7 Unit of Measu ~

o0 00000t EA Hide Column .
Reset to Fackory Settings
1 80-10000-007 Columns
1 80-10000-001 E& Properties

ure & W Quantity Ordered & 7
-10.0

3 100
100

10,0
T
20
20
10,0
400
40.0
10,0

Al il

1 Change the column order by clicking the column header in the browse screen and dragging it

to another position in the results list.

2 Adjust the column size by clicking on the border of the column header and dragging that

border to the left or the right.

3 Click the column header to sort all data in the result list on any of the columns. Click the

header again to sort the data in reverse order.

4 Each column header also features a drop-down filter option when all data has been retrieved.

Click the icon to display the available filters
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Managing Filter Fields

Managing Filter Fields

Supplier Invoice Browse for Vi, X

Actiong 7 Igl Print ° | Addto Favorites | g art fi? Chart Designer | & Refresh - Stored Searches ™
Search [14]
[Upen | [eguat T | ™l Gl
iinvoice Date ' %;guals " - - | ﬁ + x
E Supplier Invoice Browse for View - Manage Filter Fields
Label 4 Visible # Operator 4 FirstInitial Yalue 4 Second Initial Yalue 4

Supplier Code vl equals

Buzinezs Relation "l equals

Reference vl equals

Year vl equals

Dapbook Code vl equals

oucher Il equals

Posting D ate vl equals

™ equals
Invaice D ate ] equals
Invaice Status Ca v equals

hi far] 1

This option displays all the search fields possible for this type of record. You can use the Manage

Filter Fields tab to:

- Specify whether a filter field should appear on the Selection Criteria tab (Visible column).

« Specify in which order the filter fields should appear.
» Specify what operator to use when finding data to view.

 Define a persistent initial value or range of values for the filter field. The values for search
criteria entered in the actual Search Panel are not saved with the stored search. However, the

initial values entered in Manage Filter Fields are saved.

 You can refine the default search for GL accounts to retrieve only accounts with codes that are

within a number range of 1000 to 5000.
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Reports

Reporis

J Default Davbook Browse % |F{epurt - Default Daybook Brow.. |

Actions ';I.E'J Print ° ' Add to Favorites | llg - Chart @ Chart Dezign
Exportto C5Y
Export to Excel E
= Exportto POF RQJ Print | E J Refresh
= workflow EE DO | @ @ Page 1 @ @| &, g2as (6 | 8
E-rnail
B Report
Ic N Default Daybook Browse
IC QAD QMEUS USD
IC
Tran=action Type Docurrert Type  From Ertity  To Entity Daybook
et USSYEDE
I ICDEFDE
I CSTADI std cost
s 1SS-PRV 1S5-PRV
s 155-50 155-80
s 155-LUNP 155-LINP
I 15500 NOISS
I MATLALAR N OMAR
Ic RCT-PO RCT-PO
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Quick Search

Quick Search

contains == | Statswith | D|
Startz With i =
equals B¢ fsbrDd1.p E. B
containg i [ Installed Base Browse [ |
= ¢ Sales order and items E’F Default Daybook Browse '
D“‘ _ B¢ Sales Browses |

= D'r ltem Browse E‘»r Salesperson Browse :
~[E Sales Duate Bill Browse | =

E Sales Huote Browse

Bl Items

El- @ Customer

<[ Customer ltem Browse
[ Sales by Customer Browse
~[E 5/A0 by Customer Browse
[ Customer Browse

Er Salez by Customer Browse
Ewening Customer Browse

Search for a value across all of the fields in the browse.

Use the *Search For option from the Search pull-down list to retrieve all the results that contain the
search value in any of the columns. You can use this filter for all browses.Use the Contains, Starts
With, or Equals operators with the Search For filter. This option searches integers and text strings
only and does not retrieve dates. Available on the left-hand side of the panel

Create groups of browses for quick search purposes. By default, the browse groups area of the
panel is empty. Create a new browse group by right-clicking on the panel and selecting New to
create a new browse folder. Add individual browses or browse collections by selecting the folder
and dragging and dropping browses from the Applications panel. Enter a search term in the Quick
Search field and press Enter to search the browses contained in the folder for the term.
Performance is affected when the browses have many fields with underlying joins.
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Operational Metrics

Operational Metrics

Accounts Receivable X|

=2 Refresh (2 4 Print 4/ PrintPreview | | | New # Edit | ¢ AddtoFavorites | Save 38 Delete
= Customer Credit Limits @)
BEy
Name Result Total

[=H 7 Metics

-~ [@ Accounts Receivable

T |I|4

o 0 40 &0 &0 100

i Zero Credit Limit 18 L 15%

i B Accounts Receivable Analytics

: 0 20 4 & 80 100

f B Addreszes Negative Cradit Limit 0 119 Jou |l —— 0% @
H AP Operations

: B P : Greater than 90% credit © 20 4 & 80 100 )
[ AR Operations used 0 US| I—— @
- [3 Banking/GL Wors s deve ebice o 2 4 60 @ 100

; st crndit ravizes 118 118 100%
3 B Configurator b odel Completenes ast cre; | . |

|3 Configurator Operational Perfor
i B Configurator Aules Completenes

B Custamer Data . L
B . Total {Customer Credit Limits)

B Inventory Metrics

H B Irwentory Turns

B Item ABC Code Metrics

3 B Item Planning Data Integrity |—|

o Lm e e ; Tl
\L| [ | |L| Total (Accounts Receivable) .

The Browse Operational Metrics option lets you create a visible metric from browse data.
Operational metrics provide you with a live snapshot of production data, which lets you monitor in
real-time how the system is being used. You can use operational metrics to visually track any type
of browse data, including data from customized browses created in Browse Maintenance.

A number of predefined metrics can be accessed under the Metrics folder. In this case, the
Accounts Receivable metric displays different customer metric results.
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Creating Metric Collections

Creating Metric Collections

[Unﬂﬂed x}
e Refresh &) Stop (=0 Print » Print Preview | | | New ¢ Edit | ' AddtoFavorites | [ Save 3£ Delete
Untitled

Total (Untitled) |

Title | § Customers By Ste
Untitled

» Select Create Metric Collection from the Administration menu to create the initial metric
collection. The system prompts you to name the collection.

- Right-click the collection title, or select Edit|Create Metric Group to create a metric group for
the collection. You are prompted to select the parent browse for the group. Double-click the
name of the browse to select it.
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* Create Metric Group
¢ Actions ~ @ Print

Creating Metric Groups

=1/}

Search 6
TS PE-| |+ x
Viewing 1-100 of 1319 Records perpage: [100 +| @ @ G) @ J
Name # Description Niew % PowerBrowse Look-up Browse SortColumns DOrag Back Column UserlD K
| 45939 45999 _ wwids399 Yes Yes D mfg

7r987 Dock Addresses __wwir387 Yes Yes 0 mfg

75199 75199 _ ww7s199 Yes Yes 0 mfg

aad399 AASSY _ wwaadss es Yes 0 mfg

ab001 Customer Order Processing _ wwab001 Yes Ne 0 emb

ad001 Customers cmmstrQ1 Yes Mo 2 jpm

ad005 Dock Addresses admstrD6 Yes Mo 2 mfg

ad006 Employees emp_mstr Yes Yes 2 kbh

ad007 End User Addresses __wwad007 Yes Yes 0 mfg

=2d008 Address List Types __wwad008 Yes Yes 0 emb

ad010 Salespersons spmstrl1 Yes Mo 2 jpm

adl11 Commission Detail spmstrl2 Yes Ne 2 kbh

ad0l14 Suppliers wvdmstrl1 Yes Mo 2 jpm

ad015 Country Codes ctry_mstr Yes No 2 kbh

3]

Enter a name for the metric group (for example, Customers by Site) and click OK. Select a browse
on which to base the first metric.
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Creating Operational Metrics

Creating Operational Metrics

=

Tite | Customers at she 10000
Urtiled

Type | Counl - | [ | |Fercent - 1 -] [oag

Seach (1]

[site = [equan - [ o000 Plal - | + x [fmE || cewan |

&

s} Coneel

Title. Enter a title for the metric (for example, Customers at site 10000).

Type. The default type is Count. When you select the Count type, the browse filter drop-down
is unavailable. Type options depend on the type of browse. For browses that produce

numerical values as results, you can also choose Sum, Average, Maximum, or Minimum as the
Type option. When you select a type other than Count, you can then select the value to which

you apply the type.

Percent/Range. Select Percent to display the metric as a percentage of the browse total.Select
Range to display the metric as a range of figures. This option lets you increase the granularity
of the results.

Search. Select the browse filter, operator, and value to define the metric. For example, this
metric is based on the number of customers in Customer browse whose site code equals
10000. You therefore select the site code filter to equal 10000. You can set multiple filters for
the metric, as you do on a normal browse. Click Search to find out how many sites meet the
criteria (in this case, the number is 33). This information is displayed as a percentage of the
total (when you have selected the Percent display option). Use the slider controls on the
percentage bar to set the color code for thresholds.
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Editing Operational Metrics

Editing Operational Metrics

Cuglcmer Detailz =
2 Rsfresh 0 2rim X PrirtPreview | | Wew g Edit | [ scdtoFavaries b Save 3 Do
Castomer Details ()
sl Hs by Sile i
Harme Rssult Totzl
Cust + 5= 13000 33 113 u i} U 1) BU cuy a ‘
ustomers =t sh= — | | i I 9%
Giist t s L2000 8 113 u A &y =1) HU cug ¥ ‘
ustomers ctsks 1o — | | ra

Zusterrers ot sike ZH1300 u e £y ) BU “uu
-1

3 P TR . vl

Tctal (Custore-s by 5 te) .
otal {Custcmer Latails) .

You can edit metric details by right-clicking the metric name on the main screen and selecting
Edit. Click on the Save button to save the operational metric to the Metrics folder, New to save the
metric for the first time, and Replace to replace an existing metric. The metric is now available in
the Metrics folder. You can add operational metrics to Favorites. To refresh the metric information,
re-run the individual browses from within their metrics.
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Creating Excel Output From Browses

Creating Excel Output From Browses
J Sales COrder Browse X|
Actions 7[=0 Print ¢ Add to Favorites | (|j ©h=r ¥ ChartDesigner & Refresh | || New ¢ Edit
EXPORT TO_CSV
Export to Excel Eiai ' , fj = . + x @
'_K'_‘ Export to PDF \ Records per page: | 100 v_. @ Q‘) @ |® &
= Workflow
i Fmal Sold-To % Status Line ltem Number %  Unit of Measure  Quantity Ordered Quantity Open
IiliEi-!.‘g'lz'_gn—ll_lll-
@ Repor it ] i [ BT ¢ [DJE] F L ¢
1 |Sales Order Revision Sold-To Status  Line ftem Mumber Urit of Measure
fikibd Hichts | o 10116a 0l 1/a129759 EA
LSS AT 3 [10116 ' D ciTHr | 2188 Ea
HTiee 0 clil-& |4 10118 | 0 ditdr [ 4 '
i Ll & omis ' 0 ditd [ 1|at2e758 [Ea
LS 24000 |5 10116 it 2 Corfight EA
FRIE 2Lt |7 [ 112002 ' 174000 [ '
ARSI 224000 | g ap1s1Z2 ' 22000 IRIRE: [Ea
e e | g |aD15123 24000 2/288 EA
L St |10 [AD15123 24000 3
LI 2L |11 |aD1s1Z2 | 271000 [ almeAiacam <sEn
AD15123 2 4000 ?Amm?:{ . 274000 . 5.{3::'15\3.‘-‘\?,*1?",: SIEA
chuill 1 002 — i r i
chui2 1 00010000 1 3bb EA 10 10 i

Click the Actions Tab and Export to Excel button.

The export creates three worksheets in an Excel workbook, which is opened for display.
 Data. This page contains the actual data columns and headings from the printed browse.

» Search Conditions. This page displays any search conditions used to filter the printed data. The
conditions listed are field name, operator, value, and, for a range operation, the ending value.

« Info. This page lists details about the report generation including the ID of the user generating
the report, the date the report was generated, the name of the browse, and the browse program.
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Excel Integration

Loading Data for Export to Excelfor Maintenance

The Load opftion lets you retfrieve all the records from the
database and export them 1o Excel for maintenance.
Choose the Excellntegration activity from the menu and
load data into the grid using the Load option (right-click
the empty grid to selectLoad).

Export the data to a spreadsheet, open the data in Excel,
and modify it.

Right-click the grid again to selectExport fo Excel.
Save your changes.

Import the modified data (right-click the empty grid to
select Import from Excel, and click Save to create or
update the data in the system database).

Excel integration is a utility for component-based programs that lets you export data into Excel
spreadsheets, create new data within Excel, and import it to the system database, where it is
validated before being saved.

Note The more advanced bi-directional Excel integration is supported in only a subset of

components.

This activity has multiple steps:

Choose the Excel Integration activity such as Country Excel Integration.

Load data into the grid using the Load option (right-click the empty grid to select Load). The
Load option lets you retrieve all database records for a supported business component.

Export the data to a spreadsheet, open the data in Excel, and modify it (right-click the grid
again to select Export to Excel).

Save the Excel file in a folder that can be accessed so that the Excel sheet can be modified.

Modify the Excel file and save for import. Right click on the maintenance screen and select
Import From Excel.

Import the modified data (right-click the empty grid to select Import from Excel, and click
Save to create or update the data in the system database).

Notice the changes that were made.
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Using the Chart Designer

'PABrowse Chart Designer &=

Browse Chart Designer

¥-Axis Label: 1Produc’c Line Item Browse
w-Variable: | ProdLine -
Y-fxis Label:  Itemn Mumber
Group By ¥ Walues: (&) ves
-\ariables: ) Na —— oot
E&;ﬁﬂmﬁ@ izl |Count | : ; :
| x| | *)
| »] | =]
| -] | d 25.00%
| d | ~]
42.00% -
k)
*rod Line: 20
:em Mumber [Count): 42
Product Line

Generate graphical representations of browse data.
Toggle between the standard browse display (called the grid view) and the new chart view.

Use the chart view editor to select data in a browse and display the data as a pie chart or bar graph,
for example.
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Creating Charts from Browses

Creating Charts from Browses

| . Start a browse and click on the Chart
Designer icon.

2. Design a chart using the Browse Chart
Designer.

- Set X- and Y-Axis
labels

- SetX and Y variables
- Group By X Values

- Chart Title

- Chart Type

- Preview
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Chart Options

Chart Options

« Rotate and Zoom 3D Charts
- Search Charts
« Hide Titles and Legends
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Chart Options

Chart Options

« Launch Chart in New Window.
« Copy Chart to Clipboard
« Edit Chart Design

+ Interactive Charting

- For any item that has a dril-down, a split-screen
view of both the chart and the drill-down browse,
which can also be displayed as a chart.

- Click anitem in the first chart, to automatically
change the view to reflect the changed data for
the drill-down. Click an item in the chart to select
the associated row in the browse. Conversely,
click arow in a browse to select the associated
itemin the chart
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Summary

Summary

Browses let you to display selected data in
different formats. You can also display
browse data as charts or as operational
metrics. Operational metrics can be used to
display operational deficiencies in real time.
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Exercise and Knowledge Check

1 Open up the Sales Order Browse. Highlight any Sales Order and drill down by double-clicking
a Sales Order number. In the Sales Order Maintenance screen that appears, click the Sold-To
lookup.

2 Go to Supplier Invoice View and display a component-based browse.

3 Use Sales Order Browse and limit the output of the Sales Order Browse to orders for one
specific customer.

What filter did you use? What operator did you use? Send the output to an Excel sheet.
4 From the Metrics folder, display the Accounts Receivable metric.
5 Run Excel Integration for Country Browse. Delete a country and re-import the Excel sheet.
6 Run Sales Order Browse and rearrange the columns. Group the results by Sold-To.

7 Use Chart Designer to create a chart for Item Master Browse.
Label the x axis Product Line and select the variable prod line.
Label the y axis label Part Number and select the variable item number and group by count.
Select a 3D pie chart and run the chart.
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Chapter 6

Using the Character Ul
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Chapter Objectives

Chapter Objectives

+ The objective of this chapter is to infroduce
the functionality of Character User Interface
(Character Ul, or CHUI).
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Chapter Benefits

Chapter Benefits

« The user will be able to use and navigate
the Character Ul of QAD Enterprise
Applications.
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Training Flow

Training Flow

Infroduction
Navigation

« Application Help

- Programs
Browses

- Character Ul
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Introduction to Character Ul

Infroduction to Character Ul

« Character Ul depends on input from the
keyboard.

- A command-prompt interface to execute
programs

- Combinations of keystrokes to issue commands
withinprograms

- Navigationwithout use of a mouse through the
UNIX characterinterface
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Character Ul Login Screen

Character Ul Login Screen

P 172.16.28.81 - PuTTY M=%
[~

b e R pR S S RS RS NS o T | KRS PR R o i
QAD Enterprise Applications 2010 - Enterprise Edition as of Feb 24 2010
QAD
100 Innovation Place
Santa Barbara, CAL 93108

{805) 684-6614
{805) 565-4202 FAX

Copyright 1986-2009 QAD Inc:.  All rights reserwved.
This product mway not be reproduced or distributed
Aetive Users: Defined Users:

User ID: .

Password:
Domain:

Enter data or press F4 to end. |»

To start a character session, follow the procedures provided by your system administrator. The first
screen you see after launching the system lets you log in to the system. Enter the login ID assigned
by your system administrator and your password. If you have been given access to more than one
domain in the system, enter its name in the Domain field. If you have access to only one domain,

this domain displays in read-only mode. You must be a valid user to log in. Your password can be
blank only if the password in your user record is blank.

MQAD



Using the Character Ul 119

Main Menu
#P172.16.28.81 - PuTTY =Jojed
QME US : gaddb -~
‘mfmenu Main Menu 05/26/10
1. Items/Sites 13. Product Structures Z5. General Ledger
2. Addresses 14. Routings/Work Center 26. Multiple Currency
3. Inventory Control 15, Formula/Process 27. Accounts Receivable
4. Warehousing 16. Work Orders 28. Aoccounts Payable
5. Purchasing 17. Lean Manufacturing 9. Tax Management
B 18. Repetitive 30. Cost Management
7. Sales Orders/Invoice 19. Quality Management 31. Banking/Cash Mgmt
8. Configured Products  20. Product Line Plan 32. Fixed hssets
9. 21. Resource Plan 33. Enterprise Ops Flan
10. 22. Forecast/Master Plan 34.
11. Service/Support 23. Materials Rgmts Plan 35. EDI eCommerce
12. Distribution Plan 24. Capacity Romts Plan  36. System Admin
Please select a function. F4 or blank to EXIT [
Press Fz for Help [ne]

QAD Enterprise Applications has locations for 36 modules on the character-based Main Menu. In
turn, each module has one or more menus attached to it. Menus are lists of programs you use to
look up or input data.

The menus that you see depend on the security access that has been granted to your role. Only
menus with programs that you have access to display. When you enter a menu number on the
command line, the system either executes a program or displays a lower-level menu. You can keep
drilling down through the menus until you reach the appropriate level. Alternatively, you can
access a program directly by entering its Progress name—such as ppptmt. p for Item Master
Maintenance—or number at the command prompt.

If the current menu displayed is System Admin (36), you can enter 24.1 to access Database
Control (36.24.1). However, you must enter.1.4.1 to run Item Master Maintenance (1.1.4) because
it is on a different submenu.

You can also use the arrow keys to move around the menu, then press Enter to execute the
highlighted selection.
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Menu Substitution

Menu Substitution

Execucion File: Embrooi.p ‘

HNew Execution File: frmmaig.p
Jelection Label Term: FORMULA CODE_INQUIRY
Formula Code Inguircy

Fl=Go 2=Hlp 3=Ins 4=End 6=Mnu 7=Rcl S=Clr 9=Prev 10=Next 11=FBuf |$

Menu substitution lets you toggle between displaying browses and inquiries on the menu. You can
also use it to switch between customized and non-customized versions of a program. The system
administrator can use Menu Substitution Maintenance (36.4.4.7) to specify which programs are
substituted for others when you select this option. By default menu substitution is disabled. It can
be enabled for individual users in User Maintenance (36.3.1).
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Program Screen Elements

Program Screen Elements

£P 172.16.28.81 - PuTTY =a
Tifle bar = 3 7.1.1 Se d >e
i Purchase Order: lOSl Supplier: 505800 Ship-To: US-W-S ‘
——————————— Supplier Ship To
Sandwich Factory us-w-3
PngrOm = Storey Street 530 1 California Boulevard
Window
Vickery COH OH43454 San Diego Ch 92104
UNITED STATES UMITED STATES
Order Date: 07/08/07 Price Thl: Confirming: Yes Imp/Exp: No
Due Date: 07/08/07 Disc Thl: Currency: USD Language: us
Do Buyer: Ln Disc: 0.00 Taxable: No H
o e Bill Ta: US-W-5 Site: US-W-S  Fixed Price: Yes Consign: No
Frarme Sales/Job: Daybook Set: Def AP  Credit Terms: 2N 0.00
Contract: Project: Entered By: lvh
Contact: Requested By:
Remarks: Comments: No
Progress
Stortus Bar F1=Go 2=Hlp 3=Ins 4=End 6=Mnu 7=Fel §=Clr 9=Prev 10=Next 11=Buf

The title bar identifies the program currently running. What displays in the title bar depends on the
Header Display Mode setting in Security Control (36.3.24). Based on that setting, you may see any
of the following elements:

» The Progress program name, such as sosomt.p

 The program version, such as 99

» The menu number and title, such as 7.1.1 Sales Order Maintenance
= The current date

Program Window

 The program window displays the frames and fields of the current program.
Progress Status Bar

 The status bar shows the basic commands needed to navigate through the specific program
currently displayed in the program window.
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Character Ul Browse

Character Ul Browse

P 172.16.28.150 - PuTTY =<
: [ ERES SR 2R Tl
User Menu Edit Options Help Type mn [l
o5/26/10
Type Description /28!

Trans Type:[|_ >FA Fixed lssets

Trans Type Doz Type From Ic Inventory Control ook

S0 Sales Orders

> W Work Crders SDEB

Ic FDEBE

Ic CET-ADJ [=1=1=14

I1c I23-PRV PRV

1cC I38=-30 S0

Ic ISS-UNP UNF

1c ISS-w0 WOISS

ic MATL-VAR WOMVAR

Ic RCT-FOQ RCT-FQ

Ic RCT-5CR RCT-3CR
Filter = Qff
F1=Go 2=Help 3=Ins 4=End 6=Nenu 7=Rcl 8=Clr 1l=Paste v

Browses display selected data in the form of a table. Browses in the character Ul are similar to
those in the .NET Ul, but have a simpler set of features. Two types of browses are available:

« Look-up browses return the value you select to the active field in the calling program.
« Drill-down browses display, filter, or print data.

MQAD



Using the Character Ul 123

Browse Menu Bar

Browse Menu Bar

Defined in S ) )
User Function #2172.16.28.150 - PuTTY E]E
rainfenance Edit Options Help s
Default Daybook Browse 05/26/ ltl‘
Print  CTEL-F
Standard
Menu Run Program... CTRL-R Encicy To Entity Davbook
Maintenance fall  whaGow .
USSYSDE
IC ICDEFDE
Ic C3T-ADJ std cost
pifs) I35-FRV He 1y
pifs) I35-50
Ic I35-TNFP Fontents
IcC I33-Wo /| Interface Help
pifs) HATL-VAR
pifs] RCT-FO Field Help
pifs] RCT-SOR. Procedure Help SHIFT-F1
| Drill-bown ESC-TALE
Filter = Off Look-up Browse FZ
About. .. CTRL-F1 l;

To scroll through the records, use the Up and Down arrows.

The User Menu in the browse menu bar differs from the User Menu accessed by pressing F6. The
User Menu in the browse menu bar provides access to:

« Print Options

* Run Program

» Exit

Edit

Cutting text deletes it from its current location and copies it to the clipboard. Copying is similar,
but it leaves the original text in place. In both cases, you can paste the text to another location, such
as a field.

Choose the text to cut or copy.

Display the Edit menu.

This menu choice is available only when text is selected.
« Choose Cut or Copy.
« Position the cursor in the new location.
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- Display

Options

Use this option to set up filter criteria for browses. The filter criteria limit the viewable records
according to your specifications. For example, you can filter out product numbers or statuses that
you do not want to view.

« Toggle Filter :Use the toggle filter setting to turn on and off the filter criteria set up in the
browse filter options.

Help

The fastest way to get help for the current field is by pressing F2 twice: press F2 once and, if
available, a lookup browse displays), but you can also bring it up with the Help menu. With the
cursor in the field, drop down the Help menu and choose Field Help and procedure help.

Output Devices

You can send the output from reports, inquiries, and browses to a number of devices, including the
following:

« Your terminal
« A server printer
 An e-mail message

However, the character user interface does not offer as many options as the QAD .NET Ul. You
can send output to Terminal or page, but not to Window. If you select Window, the system displays
an error message. The Winprint option is designed only for Windows clients. If you select this
option, the system displays an error message. Otherwise, the output options are the same in both
interfaces. If you select a printer as the output device, be sure to use one that has been defined with
a destination type of Default in Printer Setup Maintenance (36.13.2). Just as in the QAD .NET U,
you cannot use e-mail unless it has been set up properly.
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Summary

Summary

« The Character Ul is available for SE and EE.

- InEE, component-based functions are accessible
only through the QAD .NET UI.

- Used mainly for highly repetitive heads-down
operator transactions.

MNQAD



126  Training Guide — Using the .NET Ul

Exercise
Is the .NET Ul or the character version a better option for your company? Why Or why not?

Go to the sold-to field in Sales Order Maintenance and pull up the drill-down browse, field help,
and procedure help. What key or keys did you hit?
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